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Preface

Information in this document is subject to change without notice.

© 2014 ERLPhase Power Technologies Ltd. All rights reserved. 

Reproduction in any manner whatsoever without the written permission of 
ERLPhase Power Technologies Ltd. is strictly forbidden.

This manual is part of a complete set of product documentation that includes 
detailed drawings and operation. Users should evaluate the information in the 
context of the complete set of product documentation and their particular 
applications. ERLPhase assumes no liability for any incidental, indirect, or 
consequential damages arising from the use of this documentation.

While all information presented is believed to be reliable and in accordance 
with accepted engineering practices, ERLPhase makes no warranties as to the 
completeness of the information.

All trademarks used in association with B-PRO, F-PRO, L-PRO, ProLogic, T-
PRO, S-PRO, TESLA, TESLA Control Panel, RecordGraph and RecordBase 
are trademarks of ERLPhase Power Technologies Ltd.

Windows® and Access® are registered trademarks of the Microsoft 
Corporation.

Contact Information

ERLPhase Power Technologies Ltd.

Website: www.erlphase.com

Email: info@erlphase.com

Technical Support

Email: support@erlphase.com

Tel: 1-204-477-0591
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Using This Guide

This User Manual describes the installation and operation of RecordBase Cen-
tral Station software. It is intended to support the first time user and clarify the 
details of the equipment. 

RecordBase View, the record database and graphics tool, is described in a sep-
arate user manual.

The manual uses a number of conventions to denote special information:

Example Describes

Windows Control Panel Choose the Control Panel link on the Start 
menu.

Right-click Click the right mouse button.

Recordings Menu items and tabs are shown in italics.

APT_RB_1 User input or keystrokes are shown in bold.

Text boxes similar to this one Relate important notes and information.

Different coloured icons denote the different program sections.

Blue

RecordBase
System Manager (blue)

Green

RecordBase Collector (green)

Red

RecordBase Administrator (red)

Yellow

RecordBase Monitor (yellow)
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Version Compatibility

RecordBase Central Station Version Compatibility

This chart indicates compatibility between versions of RecordBase Central 
Station and RecordBase View 

RecordBase Central Station Version
Compatible RecordBase
View Version

v2.2 v3.2

v2.1 v3.0

v2.0 v2.4

v1.5a v2.4

v1.5 v2.2

v1.4 v1.5

v1.3 v1.3

v1.2 v1.5

v1.1b v1.1 – v1.4

v1.1a v1.1 – v1.3

v1.1 v1.1

v1.0 v1.0

Please contact ERLPhase Customer Service for complete Revision His-
tory.
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PC System Requirements and Software 
Installation

Hardware The minimum hardware requirements are: 

   •  1 GHz processor

   •  2 GB RAM

   •  20 GB available hard disk space

   •  USB port

   •  Serial communication port

Operating System The following software must be installed and functional prior to installing 
RecordBase Central Station software: 

   •  Microsoft Windows XP Professional Service Pack 3

      or

   •  Microsoft Windows 7 Professional Service Pack 1 32-bit or 64-bit

Software Installation The CD-ROM contains software and the User Manual for the RecordBase 
Central Station.

Software is installed directly from the CD-ROM to a Windows PC.

The CD-ROM contains the following:

   •  RecordBase Central Station interface software

   •  RecordBase Central Station User Manual in PDF format

To Install Software 
on the Computer

Insert the CD-ROM in the drive. The CD-ROM should open automatically. If 
the CD-ROM does not open automatically, go to Windows Explorer and find 
the CD-ROM (usually on D drive). Open the ERLPhase.exe file to launch the 
CD-ROM. 

To install the software on the computer, click the desired item on the screen. 
The installation program launches automatically. Installation may take a few 
minutes to start.

To view the RecordBase Central Station User Manual the user must have Ado-
be Acrobat on the computer. If a copy is needed, download a copy at www.ado-
be.com.

Anti-virus and Anti-
spyware software

If an anti-virus/anti-spyware software on your local system identifies
any of the ERLPhase applications as a 'potential threat', it will be
necessary to configure your anti-virus/anti-software to classify it as
'safe' for its proper operation. Please consult the appropriate
anti-virus/anti-spyware software documentation to determine the relevant
procedure.
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1 System Overview

The RecordBase Central Station software provides automated collection, 
storage and network-wide access to fault and disturbance data produced by 
TESLA Model 2000, 3000 and 4000 recorders. RecordBase ensures the 
recorder data is automatically brought to a secure central location and is made 
available to staff throughout your company for display and analysis. 

TESLA Recorder

TESLA Recorder

TESLA Recorder

Modem

Modem
Re

RecordBase

View

RecordBase

View

Telephone

Network Corporate 

LAN

TESLA Recorder

Recorder

Figure 1.1: System Overview
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1 System Overview
1.1 RecordBase Features
   •  Provides automated record transfer from TESLA recorders on a call-out 

schedule (single or periodic polling) or by a recorder initiation

   •  Allows central cross-triggering of TESLA recorders for system-wide dy-
namic swing recording

   •  Includes integrated record database with search, sort and filter functions

   •  Access company-wide records on existing Windows computers through the 
corporate LAN

   •  Provides a graphical, interactive record display with timebase, phasor, har-
monic and impedance analysis tools

   •  Provides record summaries with classification and shared commentary 
work space

   •  Provides graphical and numeric export to support generation and special 
analysis

   •  Supports systems with up to 200 recorders

   •  Supports both modem and LAN communication

   •  Supports TESLA 3000/4000 cooperative mode

   •  Supports COMTRADE export with optional channel name overrides and 
choice of primary or secondary values

   •  User-selectable Active or Passive FTP communication for flexible integra-
tion into firewalled network infrastructures
1-2 RecordBase Central Station User Manual   D02261R02.20



1 System Overview
1.2 System Description
RecordBase consists of two main components: 

   •  RecordBase Central Station is a set of modules which handle record col-
lection and storage

   •  RecordBase View provides access to the data on existing desktop comput-
ers over the corporate LAN

Central Station 
Software

The Central Station handles record acquisition and cross-triggering with 
TESLA recorders and maintains the central database of records. RecordBase 
Central Station communicates with TESLA recorders using modems and/or 
LAN. RecordBase Central Station runs on a PC with Windows XP or Windows 
7 operating systems, and that PC should be dedicated to this purpose only. 

Configure RecordBase Central Station to call TESLA recorders through a mo-
dem or LAN to automatically download new records and set the call order and 
the call time.

RecordBase Central Station accepts incoming calls from a recorder through a 
modem or LAN. The user can set the recorder to notify RecordBase Central 
Station of a dynamic swing trigger or a new high priority record produced by 
the recorder.

RecordBase Central Station maintains a database of information from the re-
cords it collects. The database, as well as the downloaded record files, may be 
located on the server’s hard disk or on another drive on the network. This al-
lows the user to place the data in a more secure location managed by the com-
pany’s information systems staff (if available).

RecordBase Central Station is configured and managed using RecordBase 
Tools (Collector and Monitor) to control and to monitor its operation. These 
tools can be run on the server itself or remotely on another computer on the net-
work.

RecordBase 
View

RecordBase View is a separate software client program, for details see Record-
Base View User Manual. It is the primary tool for those who work with the data 
collected from the recorders. RecordBase View provides database search and 
sort functions, a summary display of each record, report tools and interactive 
display graphics. 

RecordBase View can run on existing desktop PCs running Windows XP or 
Windows 7 operating systems, and can access data on the RecordBase Central 
Station computer over the existing corporate LAN. The user can also run Re-
cordBase View on the same computer as RecordBase Central Station.

RecordBase 
Database

The RecordBase database is based on Microsoft Access. Data is stored in a sin-
gle central Access database file maintained by RecordBase Central Station and 
RecordBase Administrator. RecordBase View is implemented using a run-
time version of Microsoft Access. It provides access to the RecordBase data-
base. Multiple access to the central database file is controlled through record 
 D02261R02.20 RecordBase Central Station User Manual 1-3



1 System Overview
locking to ensure data integrity. Because RecordBase View uses a run-time 
version of Access, the user does not need to have Access installed on either the 
Central Station or any computer running RecordBase View. If the user does 
have a copy of Access, the user can use it to create reports and displays.

1.3 Setting Up RecordBase Central Station

RecordBase 
Central Station

For Modem Communication

   •  One or two Windows-compatible modems (internal or external) with tele-
phone lines

- One modem for outgoing calls to recorders (required)
- Second modem for incoming calls from recorders (only required if 

incoming calls via modem are to be supported)

For LAN Communication

   •  LAN card with the operating system and hardware in use

   •  Storage space suitable for records and the database. (A typical TESLA 
record is from 100 KB–1 MB.) Alternatively, the database and records can 
be located on a network drive

   •  Network connection that supports the TCP/IP protocol—required only if 
the database and records are stored on a network drive. LAN communica-
tion with TESLA is required

   •  Data backup facility recommended, if storing TESLA records on the server 
and there is no network-based backup facility

RecordBase 
View and 
RecordBase 
Tools (optional)

   •  Network connection to the Server that supports the TCP/IP protocol

   •  Printer (optional), but a print driver is required to view the report summary

TESLA 
Recorders

   •  TESLA 2000 Recorders with Firmware v2.1 or higher are required to work 
with RecordBase using modem communication

   •  TESLA 2000 Recorders with Firmware v3.6 or higher are required to work 
with RecordBase using LAN communication

   •  RecordBase supports all versions of TESLA 3000 and 4000
1-4 RecordBase Central Station User Manual   D02261R02.20



1 System Overview
1.4 RecordBase Modules
RecordBase Central Station consists of a number of software modules that 
work together. In addition to the modules that provide the underlying commu-
nication and data acquisition functions, there are user interface modules used 
to manage the system.

Modem Modem

Ethernet

TCP/IP

Server PC
Desktop PC

RecordBase

View

Server

Modules

Records and 

Database Files

RecordBase

Monitor

Yellow

RecordBase

Administrator

Red

RecordBase

Collector

Green

RecordBase

View

RecordBase

Monitor

Yellow

LAN

RecordBase

Collector

Green

Figure 1.2: RecordBase Modules

RecordBase 
Monitor

RecordBase Monitor displays the type and result of the last communication 
session with each TESLA recorder. It provides access to the system’s commu-
nication activity and diagnostic logs. The Monitor also has controls to initiate 
an immediate cross-trigger of all recorders or to initiate a record collection 
call-around. The Monitor is used by the system administrator or by general Re-
cordBase users who need basic status information and the ability to initiate ex-
ceptional record acquisition action. It can be run on the Server or an another 
PC on the network.

RecordBase 
Collector

RecordBase Collector provides control over the system’s record collection 
function. It identifies the TESLA recorders and specifies the record collection 
and cross-trigger rules. RecordBase Collector is a system administrator’s tool 
and is typically run on the Server, although it can be run from any network 
computer. 

RecordBase 
Administrator 

RecordBase Administrator provides database management tools including re-
cord deletion, modification and import. The Administrator is a system admin-
istrator’s tool and must be run on the Server.

Server Modules The Server Modules are a set of software components that control the automat-
ed record collection and communication functions. They run continuously on 
the Server machine and form the core of the RecordBase system.
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1 System Overview
1.5 RecordBase Versus TESLA Control Panel
TESLA Control Panel software is the basic user interface for the TESLA re-
corders to configure and control the recorder. RecordBase does not replace this 
function.

TESLA 2000 Control Panel version 2.1 or greater is required to 
configure a TESLA to work with RecordBase via modem. This 
version contains settings to control TESLA calls to RecordBase to 
report swing triggers or to initiate record transfer.

TESLA 2000 Control Panel version 3.6 or greater is required to 
configure TESLA to work with RecordBase via LAN.

As an alternative to the above, TESLA 3000 or 4000 Control Panel 
v1.0 or above can be used.

Running 
Control Panel 
on the 
RecordBase 
Central Station

Control Panel may be run on the RecordBase Central Station computer and 
make use of the Server’s outgoing modem or LAN card to communicate with 
recorders. 

When Control Panel is using the modem, RecordBase is unable to use it. Re-
cordBase treats this as a failed call attempt and follows its configured call retry 
rules. If the maximum number of retries is reached, RecordBase abandons the 
call attempt.

If RecordBase is using the call-out modem when trying to connect to a recorder 
using Control Panel, Control Panel reports a communication error. Try again 
when RecordBase has finished with the modem.

If your system is set up to receive modem calls from recorders, ex-
tended use of the outgoing Server modem by Control Panel could re-
sult in missed cross-triggers or record transfers. If your system is set 
up to receive LAN calls from recorders, this is not an issue.

Adding Records 
from Control 
Panel

It is possible to manually add a record that has been transferred from a recorder 
using Control Panel to RecordBase. In Control Panel, select the desired record 
from the Records List and use the Save As button to place the file on a diskette 
or a shared directory. Use RecordBase Administrator to add the record to the 
database.
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1 System Overview
Use RecordBase View to add records to the RecordBase Central Station data-
base. To add a record run RecordBase View and select File>Open. From the 
drop-down menu select the RecordBase database (C:\Users\Public\Public 
Documents\ERLPhase\RecordBase View\Database\RecordBase.mdb for Win-
dows 7, and C:\Documents and Settings\All Users\Shared Documents\ERL-
Phase\RecordBase View\Database\RecordBase.mdb for Windows XP) and 
OK. Select Add and choose the record to be added. The Records Found number 
should be updated showing that a new record has been added. For more infor-
mation refer to the RecordBase View User Manual.
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2 RecordBase Central Station Installation

For Windows 7 server setup details and installation instructions refer to “Re-
cordBase Central Station Setup Overview (for Windows 7)” on page 2-3 and 
“Detailed Server Installation (for Windows 7)” on page 2-4.

For Windows XP server setup details and installation instructions refer to “Re-
cordBase Central Station Setup Overview (for Windows XP)” on page 2-12 
and “Detailed Server Installation (for Windows XP)” on page 2-13.

2.1 Planning the Installation
This section describes RecordBase installation and the available choices. For 
system requirements see “Setting Up RecordBase Central Station” on page 1-
4.

During Server software installation there are two options—Full Server Instal-
lation and RecordBase Tools Only. 

Full Server Full Server installation installs the core server/database files and RecordBase 
Tools. Install only one instance of Full Server on the entire network. This com-
puter must have TCP/IP capability.

RecordBase 
Tools

RecordBase Tools consists of two modules—RecordBase Collector and Re-
cordBase Monitor. These modules may be installed on the server or any net-
work computer to allow the administration of RecordBase Central Station 
remotely. The network computer must have a TCP/IP link with the Server. The 
user may run approximately 15 simultaneous instances of Collector and Mon-
itor.

The table below summarizes the functionality of RecordBase Tools, for details 
see “Record Collection” on page 4-1 and “Communication Monitoring” on 
page 5-1.

Table 2.1:  Functionality of RecordBase Tools

Module Functionality

RecordBase Monitor Monitors communication with recorders.
Manually initiates system-wide swing trigger.
Initiates manual collection of records from a recorder.

RecordBase Collector Defines recorders and communication parameters.
Sets record collection times and rules.
Provides a way to shut down RecordBase.
Sets the number of logfile entries.
 D02261R02.20 RecordBase Central Station User Manual 2-1



2 RecordBase Central Station Installation
Selection of a 
Server 
Computer

To use RecordBase’s automatic record collection capability, we recommend 
that the user either dedicate a computer to run RecordBase Central Station or 
ensure that other programs that run on the shared computer are known and pre-
dictable.

We do not recommend installing RecordBase Central Station on a 
computer that runs numerous different software packages or one that 
is used for general day-to-day tasks.

Modems and 
Telephone 
Lines

The Server can be set up to use one or two modems to communicate with the 
recorders. The first modem (outgoing) is used exclusively for outgoing calls to 
the recorders to collect records or initiate a swing recording. The second mo-
dem (incoming) is optional and is used for incoming calls from the recorders 
to report new records or initiate swing cross-triggering. The need for the in-
coming modem depends on which communication features the user plans to 
use.

Table 2.2:  Communication with the Recorder

Modem Required Communication Feature

Outgoing Schedule polling calls to recorders to collect records.
Manually initiate calls to recorders to collect records.
Manually initiate swing triggering to all recorders.

Incoming Allows new record notification from recorders.
Allows cross-trigger notification from recorders.

Network 
Connection

A connection to the LAN is required if the user plans to do any of the follow-
ing:

   •  Store the database on a computer other than RecordBase Central Station

   •  Analyze records from a computer other than RecordBase Central Station

   •  Configure and monitor the record collection process from a computer other 
than RecordBase Central Station

   •  Use RecordBase Central Station to fetch records or to initiate swing trig-
gering over the LAN

   •  Allow new record notification or cross trigger notification for recorders 
over the LAN

If the user plans to store the data on the server machine and work with record 
data only on that machine, the user does not need a network connection.

TCP/IP RecordBase Central Station requires TCP/IP in order to communicate with re-
corders, for details see “Remote Access Service (RAS) Setup” on page 2-6 for 
Windows 7 and “Remote Access Service (RAS) Setup” on page 2-14 for Win-
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2 RecordBase Central Station Installation
dows XP. RecordBase Tools require TCP/IP to communicate with RecordBase 
Central Station.

RecordBase View does not require TCP/IP to access RecordBase Database; 
but the client machine (the PC that runs RecordBase View) must be in the same 
network domain as RecordBase Central Station.

Data Storage Full Server installation creates a default folder for RecordBase Database in 
"C:\Users\Public\Public Documents\ERLPhase\RecordBase Server\data-
base" for Windows 7 and "C:\Documents and Settings\All Users\Shared Doc-
uments\ERLPhase\RecordBase Server\database" for Windows XP. The 
database folder contains the file rb.mdb and all record files. Record files can 
range from about 100 KB to 1 MB each, so make sure the hard disk has suffi-
cient storage space. We recommend that the user does a regular backup of the 
database folder.

2.2 RecordBase Central Station Setup Overview (for 
Windows 7)

This section provides an overview of the steps involved in setting up Record-
Base Central Station. Detailed instructions appear in following sections.

Decide first whether you wish RecordBase to use one modem (for calling 
TESLA recorders), two modems (one for calling TESLA recorders and another 
for accepting calls from TESLA recorders) or LAN. RecordBase can also use 
a combination of modems and LAN.

RecordBase 
with 1 Modem 
Overview

In this case RecordBase calls TESLA recorders for record collection.

1.  Install Server software from the CD-ROM.

2.  Define IEDs, for details see “Adding a Recorder to the List” on page 4-4.

3.  If desired, allow remote computers to access the RecordBase Database by 
creating a share on the database folder (C:\Users\Public\Public Docu-
ments\ERLPhase\RecordBase Server\database).

4.  Ensure Windows 7 Professional Service Pack 1 (32-bit or 64-bit) or later is 
applied

RecordBase 
with 2 Modems 
Overview

In this case RecordBase is not only able to call TESLA recorders, but is also 
able to receive calls from them. In addition to the above steps, perform the fol-
lowing:

1.  Create a new user account on the server machine for the TESLA recorders, 
for details see “New User Account Setup” on page 2-4.

2.  From Windows Control Panel, select Category from the view by drop down 
box, and go to System and Security/Administrative Tools/Services. Ensure 
that the Routing and Remote Access service is set to run automatically and 
modems are configured and functional, for details see “Remote Access 
Service (RAS) Setup” on page 2-6.
 D02261R02.20 RecordBase Central Station User Manual 2-3



2 RecordBase Central Station Installation
RecordBase 
with LAN 
Overview

In addition to (or instead of) modems, RecordBase has the ability to call TES-
LA Recorders and receive calls from them over the LAN.

1.  Follow the steps according to “RecordBase with 1 Modem Overview” on 
page 2-3, starting with step 1.

2.3 Detailed Server Installation (for Windows 7)

New User 
Account Setup

New User Account setup is only necessary for installations with two modems 
(IEDs are allowed to call in and out).

1.  From Windows Control Panel, select Category from the view by drop down 
box, and go to System and Security/Administrative Tools/Computer Man-
agement.

2.  Under Local Users and Groups, right-click on Users and choose New Us-
er... from the pop-up menu.

Figure 2.1:  New User

3.  Create a new user account with the name tesla2000, type password as 
T3S5A3720 and confirm.

4.  Uncheck User must change password at next logon.

5.  Check User cannot change password.

6.  Check Password never expires.
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2 RecordBase Central Station Installation
 

Figure 2.2: New Account Information

7.  Click the Create button and close the New User dialog box.
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2 RecordBase Central Station Installation
Remote Access 
Service (RAS) 
Setup

Remote Access Service (RAS) Setup is only necessary for installations with 
two modems (IEDs are allowed to call in and out). Skip this section if the user 
doesn’t need modem access to/from recorders.

1.  From Windows Control Panel, select Category from the view by drop down 
box, and go to System and Security/Administrative Tools/Services.

2.  Check the status of Routing and Remote Access service. The start-up type 
should be set to Automatic and its status should be Started.

Figure 2.3: RAS Setup

3.  If it is not, double-click it to bring up Properties, set the Start-up Type to 
Automatic. Click on Apply, and then click Start to start the service.
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2 RecordBase Central Station Installation
Figure 2.4: RAS Properties

4.  From Windows Control Panel, select Category from the view by drop down 
box, and go to Network and Internet/Network and Sharing Center and se-
lect Change adapter settings from the left panel. 

5.  If Incoming Connections does not appear, press the Alt key to show the 
menu bar. Select File>New Incoming Connection..., and follow the wizard 
to create a new incoming connection.

6.  Double-click Incoming Connections.

Figure 2.5: Network Connections

7.  Choose the dial-in modem to allow incoming calls.
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2 RecordBase Central Station Installation
Figure 2.6: Incoming Connections Properties

8.  Go to the Users tab and allow the “tesla2000” user to connect.

9.  Check Always allow directly connected devices such as handheld comput-
ers to connect without providing a password
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2 RecordBase Central Station Installation
Figure 2.7: TESLA User Connection

10.  Go to the Networking tab, ensure Internet Protocol Version 4 (TCP/IPv4) 
is checked, select it and click Properties.
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2 RecordBase Central Station Installation
Figure 2.8: Networking Properties

11.  Uncheck the Allow callers to access my local area network.

12.  Check the Specify TCP/IP addresses and enter a From address of 
192.168.102.160 and a To address of 192.168.102.180.

13.  Uncheck the Allow calling computer to specify its own IP address.L 

Figure 2.9: TCP/IP Address
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2 RecordBase Central Station Installation
14.  Click OK to close the Incoming IP Properties dialog box.

15.  Click OK to close the Incoming Connections Properties dialog box.

Skip this section if the user doesn’t need modem access to recorders.
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2 RecordBase Central Station Installation
2.4 RecordBase Central Station Setup Overview (for 
Windows XP)

This section provides an overview of the steps involved in setting up Record-
Base Central Station. Detailed instructions appear in following sections.

Decide first whether you wish RecordBase to use one modem (for calling 
TESLA recorders) or two modems (one for calling TESLA recorders and 
another for accepting calls from TESLA recorders). The latter case involves 
more installation steps.

RecordBase 
with 1 Modem 
Overview

In this case RecordBase calls TESLA recorders for record collection.

1.  Install Server software from the CD-ROM.

2.  Define IEDs, for details see “Adding a Recorder to the List” on page 4-4.

3.  If desired, allow remote computers to access the RecordBase Database by 
creating a share on the database folder (C:\Documents and Settings\All Us-
ers\Shared Documents\ERLPhase\RecordBase Server\database).

4.  Ensure Windows XP Professional Service Pack 3 or later is applied.

RecordBase 
with 2 Modems 
Overview

In this case RecordBase is not only able to call TESLA recorders, but also able 
to receive calls from them. In addition to the above steps, perform the follow-
ing:

1.  Create a new user account on the server machine for the TESLA recorders, 
for details see for details see Figure 2.11: New Account Information on 
page 2-14.

2.  From Windows Control Panel, click on Switch to Classic View if it is not  in 
Classic View, and go to Administrative Tools/Services. Ensure that the 
Routing and Remote Access service is set to run automatically and modems 
are configured and functional, for details see “Remote Access Service 
(RAS) Setup” on page 2-14.

3.  Continue as in the section “RecordBase with 1 Modem Overview” starting 
with Step 2.

RecordBase 
with LAN 
Overview

In addition to (or instead of) modems, RecordBase has the ability to call TES-
LA Recorders and receive calls from them over the LAN.

1.  Follow the steps according to  “RecordBase with 1 Modem Overview” on 
page 2-12 starting with step 1.
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2 RecordBase Central Station Installation
2.5 Detailed Server Installation (for Windows XP)

New User 
Account Setup

New User Account setup is only necessary for installations with two modems 
(IEDs are allowed to call in and out).

1.  From Windows Control Panel, click on Switch to Classic View if it is not in 
Classic View, and go to Administrative Tools/Computer Management, 
open the Local Users and Groups branch and right-click Users.

2.  Choose New User... from the pop-up menu.

Figure 2.10: New User

3.  Create a new user account with the name tesla2000, type password as 
T3S5A3720 and confirm.

4.  Uncheck User must change password at next logon.

5.  Check User cannot change password.

6.  Check Password never expires.
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Figure 2.11: New Account Information

7.  Click the Create button and close the New User dialog box.

Remote Access 
Service (RAS) 
Setup

Remote Access Service (RAS) Setup is only necessary for installations with 
two modems (IEDs are allowed to call in and out). Skip this section if the user 
doesn’t need modem access to/from recorders.

1.  From Windows Control Panel, click on Switch to Classic View if it is not in 
Classic View, and go to Administrative Tools/Services.

2.  Check the status of Routing and Remote Access service. The start-up type 
should be set to Automatic and its status should be Started.
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Figure 2.12: RAS Setup
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3.  If it is not, double-click it to bring up Properties, set the Start-up Type to 
Automatic. Click on Apply, and then click Start to start the service.

Figure 2.13: RAS Properties

4.  From Windows Control Panel, click on Switch to Classic View if it is not in 
Classic View, and go to Network Connections.

5.  Double-click Incoming Connections.
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Figure 2.14: Network Connections

6.  Choose the dial-in modem to allow incoming calls.

Figure 2.15: Incoming Connections Properties

7.  Go to the Users tab and allow the “tesla2000” user to connect
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Figure 2.16: TESLA User Connection
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8.  Go to the Networking tab, ensure Internet Protocol (TCP/IP) is checked. Se-
lect it and click Properties.

Figure 2.17: Networking Properties
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9.  Uncheck Allow callers to access my local area network.

10.  Check the Specify TCP/IP addresses and enter a From address of 
192.168.102.160 and a To address of 192.168.102.180.

11.  Uncheck Allow calling computer to specify its own IP address.

Figure 2.18: TCP/IP Address

12.  Click OK to close the Incoming TCP/IP Properties dialog box.

13.  Click OK to close the Incoming Connections Properties dialog box.

Skip this section if the user doesn’t need modem access to recorders.
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2.6 Commissioning and Verification of RecordBase
Communication must be tested to verify that RecordBase is configured 
properly. Before RecordBase can communicate with a remote TESLA 2000 
recording system, the recorders must have Firmware version 2.1 or greater (for 
modem communication) or version 3.6 or greater (for LAN communication) 
and RecordBase Central Station must be running during the verification 
process. To run RecordBase Central Station, select Start>All 
Programs>ERLPhase>RecordBase>RecordBase System Manager. Since the 
Server modules run invisibly in the background, the blue RecordBase icon at 
the bottom right corner indicates a running RecordBase Central Station.

To communicate with a remote TESLA 3000/4000 recording system, the 
recorders must have Firmware version 1.0 or greater.

Testing the Dial-
Out and/or 
Outgoing LAN 
Connection

This procedure verifies that RecordBase is able to dial out and communicate 
with remote TESLA recorders. It applies whether the RecordBase system com-
municates with TESLA recorders using modems or LAN. 

Requirements

   •  TESLA recorder

   •  RecordBase Collector

   •  RecordBase Monitor

Procedure Overview

   •  Define a TESLA recorder to RecordBase.

   •  Initiate a call from RecordBase to the TESLA recorder. If the call succeeds, 
RecordBase automatically fetches its UnitID and Serial Number.

Procedure Details

1.  Run RecordBase Collector and create a New IED by selecting the New but-
ton and input its Location and Phone Number or IP address. 

2.  The TCP/IP Port Selection dropdown is used to define the port that Record-
Base uses to communicate with a TESLA.

3.  Select 2000 for the following:

   •  TESLA 2000

   •  TESLA 3000 having firmware prior to version 2.6

   •  TESLA 4000 having firmware prior to version 1.4

   •  Select 7631 for all TESLA 4000 having firmware 1.4 or higher, and TESLA 
3000 having firmware 2.6 or higher.
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For TESLA 4000 having firmware 1.4 or higher, and TESLA 3000 
having firmware 2.6 or higher, the port number can be changed from 
the Maintenance Menu of the TESLA. The default port is 7631.

4.  Select OK to exit the New dialog box.

Figure 2.19: Set Up New IED

5.  Select the newly created IED from the list and the Edit button. Ensure the 
phone number or IP address is correct and select the Get Information From 
IED button. RecordBase should start calling the IED within ten seconds. 
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Figure 2.20: Edit IED

6.  During the call, use RecordBase Monitor to view the status. When the call 
ends, if all goes well, the Call Status column should say successful and the 
unit’s UnitID field should have been automatically filled in. There will also 
be an entry for this operation in Monitor’s Activity Log view.

Testing the Dial-
In and/or 
Incoming LAN 
Connection

This procedure verifies that TESLA recorders can successfully dial into Re-
cordBase and communicate with it. This step is only applicable if RecordBase 
has been set up with two modems or if it communicates with TESLA recorders 
over LAN. If the RecordBase system only has one modem, skip this section.

Requirements

   •  TESLA recorder

   •  TESLA Control Panel

   •  RecordBase Monitor

Procedure Overview

   •  Configure the TESLA recorder to notify RecordBase of new records.

   •  Trigger the recorder and allow it to call RecordBase.
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   •  Use RecordBase Monitor to view the call status and activity. 

Procedure Details

1.  Verify the Dial-Out Connection by checking the preceding instructions. Re-
cordBase only accepts calls from IEDs that are known to it (known IEDs 
appear in RecordBase Monitor’s IED list), so the user must first establish a 
working connection with an IED.

2.  Configure the TESLA recorder (using TESLA Control Panel) to notify Re-
cordBase when it has new records.

3.  Trigger the TESLA to generate a record (using Control Panel). This should 
force it to call RecordBase.

4.  Monitor the activity using RecordBase Monitor (on the main IED Status 
screen). After the call is complete, the Call Type for that IED should be in-
coming, and the Call Status should be new records. An entry also appears 
in the RecordBase Monitor’s Activity Log view.

Testing 
Database 
Operation

This procedure helps to verify that TESLA recorders can successfully contact 
RecordBase and communicate with it. This step is only applicable if Record-
Base has been set up with two modems. If the RecordBase system only has one 
modem, skip this section.

Requirements

   •  TESLA recorder

   •  TESLA Control Panel

   •  RecordBase Monitor

   •  RecordBase Administrator (part of RecordBase Central Station installa-
tion)

Procedure Overview

   •  This procedure extends the Dial-Out test to actually fetch records and en-
sure they are entered into the RecordBase Database.

Procedure Details

1.  Verify the Dial-Out Connection by using the preceding instructions.

2.  Configure the TESLA recorder (using TESLA Control Panel) not to notify 
RecordBase.

3.  Create one or more records on the TESLA recorder (using TESLA Control 
Panel).

4.  In RecordBase Monitor, select the IED from the list and select the Collect 
Now button. This queues a call to that IED for record collection. 

5.  Use RecordBase Monitor’s Activity Log and Diagnostic Log views to 
watch the process. When the call begins, the Diagnostic Log view shows 
the name of each record as it is transferred.
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6.  Wait until at least one record is transferred and then run RecordBase Ad-
ministrator. Verify that an entry for the transferred record appears in its 
record list.
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RecordBase Central Station software consists of a set of cooperative software 
modules to handle communication, record collection and the central database.

This chapter describes the software modules and how to start, stop and monitor 
the RecordBase Central Station. 

3.1 RecordBase Central Station Modules
The RecordBase Central Station modules run together on the designated Serv-
er computer providing the core RecordBase functionality.

Table 3.1:  RecordBase Central Station Modules

Server Module Function

RecordBase System Manager Main Server module. Handles start-up and shut-
down, monitors the other modules, handles inter-
module communication.

RecordBase Collection Manager Record collection and cross-triggering.

RecordBase Session Manager Communication with recorder via modem.

RecordBase LAN Session Manager Communication with recorder via LAN.

RecordBase Logfile Manager Activity and diagnostic logs.

RecordBase Database Manager Interface to database.

The Server modules run invisibly as background processes on the computer; 
they do not have a user interface window.

Interact with them using the RecordBase Monitor and RecordBase Collector 
modules on the server or on another computer that has a TCP/IP link with the 
server. 
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3.2 Starting, Monitoring and Stopping the Server 
Software

For proper operation of RecordBase View, ensure that the Windows 
Date format is set to YYYY-MM-DD format. Change the date format 
by going to Windows Control Panel, Regional Settings, Date Tab.

Starting 
RecordBase 
Modules

The RecordBase System Manager module handles system start-up and shut-
down, automatically starting or stopping other server modules as required.

To start the server software, run RecordBase System Manager by launching it 
through the Start menu (Start>All Programs>ERLPhase>RecordBase>Re-
cordBase System Manager).

Configure the computer to automatically start RecordBase System Manager by 
placing a short-cut to RecordBase System Manager in the Start Menu.

At present, RecordBase System Manager does not support running 
as a Windows service.

Checking 
RecordBase

The RecordBase Central Station modules are monitored continuously by the 
RecordBase System Manager. It ensures that the other modules are running 
and restarts them if required. 

When running either RecordBase Monitor or RecordBase Collector, the status 
of their link with RecordBase System Manager is shown at the bottom of their 
windows. If the status says “Connected,” then the user knows that all the Serv-
er modules are up and running.

Figure 3.1:  RecordBase Tray Icon

On the Server machine, if RecordBase Central Station is running, there is a 
small RecordBase icon at the lower right corner of the screen. If it is hidden, 
click on the Upward arrow button on the system tray to show hidden icons.

Alternatively, use the Windows Task Manager to determine if the RecordBase 
modules are running. Press Ctrl + Alt + Del, and select  Start Task Manager,   
and go to the Processes tab. SystemManager.exe should be one of the process-
es running.
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Figure 3.2: Task Manager

Check if Remote Access Server is running using Start>Control Panel>Admin-
istrative Tools (when viewed by 'small icons')>Services.

Stopping 
RecordBase

To shutdown RecordBase Central Station, use RecordBase Collector’s Shut-
down button under it’s Server Info tab.

3.3 RecordBase Central Station Database
RecordBase System Manager module starts, stops and adds new records to the 
database automatically.

The central database is maintained in a Microsoft Access data file called 
RB.mdb in the default directory C:\Users\Public\Public Documents\ERL-
Phase\RecordBase Server\database for Windows 7 and C:\Documents and 
Settings\All Users\Shared Documents\ERLPhase\RecordBase Server/data-
base for Windows XP. The records uploaded from the recorders are stored 
here.

The RecordBase Central Station database is a shared database allowing access 
by multiple users on the network through RecordBase View. Database access 
by multiple users is fully supported.
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RecordBase automatically retrieves records from TESLA recorders through its 
modem or LAN and adds them to its database. Record retrieval can be config-
ured to occur on a scheduled polled basis initiated by RecordBase or on a re-
port-by-exception basis initiated by a recorder.

When RecordBase is collecting from a TESLA 3000/4000 recorder that is part 
of a Cooperative group, RecordBase will attempt to fetch record fragments 
from each member of the Cooperative group and automatically combine them 
into a single record.

It is assumed that before using RecordBase Central Station with Cooperative 
group units, the user is familiar with, and has verified proper operation of, the 
Cooperative group using TESLA Control Panel.

4.1 RecordBase Collector Module
RecordBase Collector is a utility program used to configure RecordBase’s re-
cord retrieval and cross-triggering services. 

Figure 4.1:  Collector Module
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RecordBase Collector can be run on the Server or on any computer on the LAN 
that has a TCP/IP link with the server.

Running 
RecordBase 
Collector the 
First Time

If RecordBase Collector is running on the same computer as RecordBase Cen-
tral Station, then skip this section.

Running the RecordBase Collector for the first time, set the Server ID under 
the Server Info tab to the name of the computer running RecordBase Central 
Station. Alternatively type in the IP address of the computer running Record-
Base System Manager if it is known.

To determine the name of the computer running RecordBase Central Station:

Figure 4.2: Identify Server Computer

1.  On the computer running RecordBase Central Station, go to the Start Menu,  
right-click on Computer, and select Properties.

2.  The Server ID is the text in the Computer Name field. 
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Figure 4.3: Collector Module - Server Info tab

Collector 
Collection 
Status

The Collector shows the status of its communication link with the server in its 
Status Bar at the bottom of its window. 

If the communication with the server is working, the status says “Connected.” 
If it says “Not Connected,” 

1.  Check that the correct Server ID name (or IP address) has been entered in 
the Server Info tab, for details see for details see Figure 4.3: Collector 
Module - Server Info tab on page 4-3.

2.  Check that the server computer is accessible on the network by using Win-
dows Network Neighborhood and/or Explorer. 

3.  Check that the computer the user is working on and the Server have estab-
lished a TCP/IP connection by running ping Server ID. Do this in the Run 
service available through the Windows Start menu. The TCP/IP link is 
working if the server responds to the ping.

4.  Check that the server is running the RecordBase application by bringing up 
Task Manager on the server (Ctrl, Alt and Del keys simultaneously) and 
checking for SystemManager.exe in the Processes view.
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4.2 Adding a Recorder to the List
Use RecordBase Collector to add each TESLA recorder to RecordBase’s list.

1.  The recorder list is shown under the Collector’s IED Info tab. 

2.  To add a new recorder to the list, use the New… button. 

Figure 4.4: Collector Module Record List
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Figure 4.5: Setup New IED

3.  Enter the phone number or IP address and the location of the TESLA the 
user is adding. Note that if a phone number is selected, a modem must be 
selected as well from the drop-down modem list.

4.  Select the OK button.

Before RecordBase will accept a call from an IED, the IED Serial # 
must be known.
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TESLA 3000/
4000 
Cooperative 
Mode

When adding a TESLA 3000/4000 recorder that is part of a Cooperative group, 
it is important to add only one of the group members to the list.  Typically, this 
will be the one recorder that is the ’gateway’ to the Cooperative group.  When 
RecordBase contacts this recorder it will automatically detect that it is part of 
a Cooperative group and will fetch/combine record fragments appropriately

Note that if multiple TESLA 3000/4000 recorders from the same Cooperative 
group are mistakenly added to the list and RecordBase performs cross-trigger-
ing, those recorders will be cross-triggered multiple times for the same event, 
resulting in undesirable behavior.

FTP Transfer 
Mode

Prior versions of RecordBase Central Station exclusively used Active FTP for 
record transfers. Starting with v2.2, RecordBase Central Station allows Passive 
FTP to be used as an alternative by checking the Use PASSIVE mode for FTP 
transfers. This is a global setting and applies to all record transfers regardless 
of IED.
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4.3 IED Collection Rules

Polled Record 
Collection

RecordBase can be set to poll its recorders on a scheduled basis and automati-
cally transfer new records to the central database.

To configure record collection for a recorder, select the unit in the RecordBase 
Collector’s IED Info tab, then select the Collection Rules button.

Figure 4.6: Collection Rules
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Enable Polling To enable scheduled polling for new records for this recorder, select the Enable 
Polling box.

Collection Time Each recorder can be called at a specified time, on any day of the week to poll 
and retrieve new records. 

Only records that are not already contained in the RecordBase database are 
transferred. 

Call Order Control the order in which recorders are called through the Start Call After 
field. The first recorder to be called is the one with the earliest Start Call After 
time. When that first call is complete, a call is placed to the recorder with the 
next earliest Start Call After time even if it is presently later than that time due 
to a long call with the first recorder. If an attempt to communicate with a re-
corder fails, RecordBase will reschedule the call and go on to the next in the 
queue.

Polls During 
Period

Control the polling method by choosing either Single Poll or Periodic. If set to 
Single Poll, only one successful poll will occur during the parameters set in the 
Calling Window. If set to Periodic, multiple polls can occur during a polling 
window.

Limiting Late 
Calls

A call window can be defined with the End Call Before parameter which limits 
how late a call can take place. If No Limit is selected, the call can take place 
any time after the Start Call After time. 

Limiting Record 
Transfers

Limit the call session by the Maximum Records Transferred settings. This lim-
its the number of records that can be transferred during the call and Time Limit 
of each call.

Call Scheduling If a call to a recorder is unsuccessful (for example, due to a busy signal), the 
call will be rescheduled. If a call to another recorder can be made, RecordBase 
will automatically switch to that call. If not, RecordBase will try the same re-
corder again. The Delay Between Attempts setting can be used to ensure a min-
imum interval between call attempts to the same recorder. The Maximum 
Attempts setting limits the number of times a call is retried.

Record Transfer 
Order

The Transfer Newest/Oldest Records First selection lets you determine how 
RecordBase should sequence record transfer when there are multiple records 
available. This is important if you have placed limits on the number of records 
that can be transferred in a session or on the duration of a call. 

Erasing 
Records from 
the Recorder 
after Transfer

You have the option of automatically erasing records from a recorder after they 
have been transferred and verified to be whole and error-free. Deletion of the 
record on the recorder takes place only after the integrity of the transferred re-
cord has been verified using an error detecting CRC embedded in TESLA re-
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cords. If an error is detected in the transferred file the problem is reported in 
the Diagnostic log, for details see “Diagnostic Log” on page 5-4.

RecordBase determines which records to transfer from a recorder by compar-
ing the record list on the recorder with the contents of the RecordBase data-
base. If you choose not to delete records on the recorder, RecordBase will still 
only transfer the new records.

Selecting the Delete After Transfer and Verification option is recom-
mended. It speeds up the check for new records and makes it easier 
to manage the recorders.

If this option is selected and RecordBase Central Station is connect-
ed to a TESLA that is part of a Cooperative group, the corresponding 
record fragments (partial records) will be deleted from each recorder 
after a successful transfer.

COMTRADE 
Options

Any record transferred from a TESLA can be automatically converted into 
COMTRADE format. This is enabled by checking the Convert To COM-
TRADE After Transfer box. The file format can be selected to be either ASCII 
(default) or Binary, with the export data selected as either Primary or Second-
ary. An output folder can be specified.

By default the generated COMTRADE files adhere to the COMTRADE 1999 
standard, and all channels in the record (including any derived/virtual chan-
nels) are exported.

The COMTRADE output filename is derived from the records trigger time, 
and follows a format similar to that produced by TESLA 4000 Control Panel 
(e.g. 2009-12-24-10.42.27.000). A single TESLA record can generate several 
COMTRADE files, depending on the record type. Files will have extensions 
of .cfg, .dat, and .hdr.

Channel names can optionally be overridden in the exported COMTRADE 
files by checking the Override Channel Names box. In this case channel names 
are taken from a .INI file that must be selected and edited by the user. Record-
Base Central Station comes with a default .INI file that can be used as a starting 
point; it also contains comments and instructions to assist with editing.

Note that for low-speed (swing) records, the COMTRADE output will contain 
two output channels (magnitude and phase) for each analog channel present in 
the original record. In this case a single channel override name in the .INI file 
will affect both magnitude and phase channels in the COMTRADE output.
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If recorders are set to cross-trigger, it is recommended that a sepa-
rate COMTRADE output directory is assigned for each one. Other-
wise, converted COMTRADE records may overwrite one another 
since COMTRADE filenames are based on trigger time (which is 
identical in the case of cross-triggered recorders).

4.4 Manually-Initiated Record Collection
You can manually initiate a record collection call to one or more recorders in 
addition or as an alternative to scheduled poll calls. Use the RecordBase Mon-
itor utility to do this. In the IED Status tab select one or more recorders and the 
Collect Now button to initiate the calls, for details see “RecordBase Collector 
Module” on page 4-1.

Figure 4.7: RecordBase Monitor

The call order for manually-initiated calls follows the order in which the re-
corders appear in the list.

The collection rules in place for each recorder are followed, for details see 
“Polled Record Collection” on page 4-7, except that the start and end times do 
not apply.
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4.5 Recorder-Initiated Record Collection
Record transfer can also be initiated by the recorder. TESLA recorders can be 
configured to call RecordBase when new records are created. 

A recorder must be in RecordBase’s list (for details see “Adding a Recorder to 
the List” on page 4-4), for an incoming call from it to be accepted. If a call is 
received from a recorder that is not in the list, the call is declined and the error 
is logged in the Diagnostic Log.

RecordBase must have a separate dial-in modem or LAN connection 
to receive incoming calls from a recorder.

RecordBase responds to incoming calls by checking for cross-trigger events in 
the recorder’s log and checking for new records. If new records are available, 
RecordBase hangs up and calls back on its dial-out modem or LAN to handle 
the record transfer ensuring that the dial-in modem is available to receive in-
coming calls. If the dial-out modem is busy, the call is queued. RecordBase 
transfers all new records from the recorder, except where limited by settings.

It uses the same settings to limit the session, manage retry attempts and control 
the transfer process as a RecordBase initiated poll call, for details see “Polled 
Record Collection” on page 4-7.

When setting up recorder-initiated record collection on a Cooperative group, it 
is important that only the 'gateway' member be set to notify RecordBase. The 
other members of the Cooperative group should not notify; when RecordBase 
receives notification from the 'gateway' member, it will automatically fetch re-
cordings from all of the Cooperative group's members.
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4.6 Central Cross-Triggering
RecordBase can be set to trigger dynamic swing records (via modem or LAN 
on all its recorders in response to an appropriate trigger from one recorder. The 
result is a set of records that gives a synchronized system-wide snapshot of the 
disturbance. Any of a recorder’s detectors can be set to initiate a notification 
call to RecordBase when triggered. 

A recorder must be in RecordBase’s list to accept an incoming call, for details 
see “Adding a Recorder to the List” on page 4-4. A call received from a record-
er not on the list is declined and the error is logged in the Diagnostic Log.

RecordBase must have a LAN connection or a separate dial-in mo-
dem to receive incoming calls from a recorder, for details see “Mo-
dems and Telephone Lines” on page 2-2 and “Network Connection” 
on page 2-2.

Cross Trigger 
Process

When the incoming call is received, RecordBase checks the recorder’s event 
log. If a new central cross-trigger event is found, RecordBase initiates record-
ing on the other recorders by calling them and issuing swing trigger com-
mands.

The swing trigger command includes the time stamp of the initiating event. 
Each recorder goes back in its 20 minute swing data running buffer and cap-
tures a record for the same time frame using the time stamp as its trigger time 
and including pre-trigger and post-trigger data according to the recorder’s con-
figured recording parameters.

If the swing trigger command cannot be delivered to a recorder while the data 
is still present in the 20 minute buffer, that unit will not be able to provide a 
recording.

Trigger 
Rejection 
Window

To avoid needless loading of the communication channels, RecordBase ig-
nores triggers whose time stamp is within 10 seconds of any previous trigger. 
Ignored triggers are reported in the Diagnostic Log.

Cross-Trigger 
Settings

Settings to control the RecordBase swing cross-trigger handling are available 
as part of the collection rules, for details see for details see Figure 4.6: Collec-
tion Rules on page 4-7.

The Enable Cross-Triggering of Other IEDs selector allows or prevents trigger 
reports of a recorder from initiating records on other units.

The Retrieve Cross-Triggered Records Immediately setting tells RecordBase 
to call each recorder to pick up the records. If this is not enabled, the record 
won’t be picked up until the next scheduled poll or until a recorder-initiated re-
cord transfer call is received. 
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TESLA 3000/
4000 
Cooperative 
Mode

When RecordBase cross-triggers a TESLA 3000/4000 that is part of a Coop-
erative group, all recorders participating in that group will be automatically 
triggered.

It is important that only the 'gateway' TESLA be set to notify (cross-trigger) 
RecordBase. The other members of the Cooperative group should not be set to 
do this.

4.7 Manual Cross-Triggering
You can manually initiate time-coordinating cross-triggering of dynamic 
swing records on all the recorders. 

Use the Cross-Trigger button under the IED Status of the RecordBase Monitor 
utility to do this, for details see “RecordBase Monitor Module” on page 5-1.

The Cross-Trigger button initiates a call to each recorder and issues a com-
mand to captures a dynamic swing record. 

The trigger time for all the records is the time at which the Cross-Trigger but-
ton was selected. All recorders are called, regardless of any selections made in 
the record list.

Note that manual cross-triggers generate swing recordings having a 
status of 'IRIG-B unsynchronized', regardless of the state of the unit's 
IRIG-B input.
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RecordBase provides information on the current communication status of each 
recorder and a log of communications activity and problems through the Re-
cordBase Monitor module. 

5.1 RecordBase Monitor Module
RecordBase Monitor is a utility program that provides information on the com-
munication between RecordBase and the TESLA recorders. It provides:

   •  Time and result of last call made with each recorder

   •  Communication Activity Log

   •  Diagnostic Log

   •  Manual cross-triggering of recorders

   •  Manual collection of records from recorders

RecordBase Monitor can be run on the Server or on another computer on the 
network that has a TCP/IP connection with the server.

Monitor shows the status of its communication link with the server in its Status 
Bar at the bottom of its window. The Status Bar should say “Connected.”

Before you can run RecordBase Monitor on a computer for the first 
time, you must first identify the network name of the RecordBase 
Central Station by using the RecordBase Collector to set the Server 
ID field.
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5 Communication Monitoring
Figure 5.1:  RecordBase Monitor

IED Status

IED Status Tab Location Last Call Call Type Call Status

Status Bar

Figure 5.2: IED Status
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5 Communication Monitoring
The status of the last call made with each recorder is shown under the IED Sta-
tus tab of RecordBase Monitor. The Last Call column indicates the reason for 
the most recent call with the recorder. The Call Result column shows dynamic 
status information during a call. When the call is over, it indicates the outcome 
of the call. See table following.

Table 5.1:  IED Status

Call Type Call Status Application

Scheduled Pick-up Connecting, fetching ID, fetching list, 
re-scheduled, failed, successful, 
fetching records

A scheduled record pick-
up

New Record Pick-up Connecting, fetching ID, fetching list, 
re-scheduled, failed, successful, 
fetching records

A record pick-up in 
response to “New 
Records” notification from 
an IED

Xtrig Record Pick-up Connecting, fetching ID, fetching list, 
re-scheduled, failed, successful, 
fetching records

A record pick-up after a 
cross trigger

Manual Pick-up Connecting, fetching ID, fetching list, 
re-scheduled, failed, successful 
fetching records

A manual record pick-up 
(user pressed the “Collect 
Now” button)

Cross Trigger Connecting, fetching ID, re-sched-
uled, failed, triggering, triggered

A call to cross trigger an 
IED

Incoming Fetching ID, failed, successful, cross-
trigger, new records

An incoming call from an 
IED

Synchronization Connecting, fetching ID, re-sched-
uled, failed, successful

A call to fetch an IED’s 
identification

Activity Log
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5 Communication Monitoring
Figure 5.3: Activity Log

A communication activity log provides a history of the calls made to and from 
each recorder. The log is available under the Activity Log tab of the Record-
Base Monitor utility. The log specifies the date and time of the call, the name 
of the recorder, the call direction (incoming or outgoing) and the call type. The 
log display can show communication with all recorders.

The activity log is circular, the oldest entries are automatically over written 
when its maximum size is reached. The size of the RecordBase logs is set 
through the Log Info tab of the RecordBase Collector module. 

Changing the Activity Log size clears all log entries.

Diagnostic Log

Figure 5.4: Diagnostic Log

Communication difficulties between RecordBase and the recorders are logged. 
The log is available under the Diagnostic Log tab of the RecordBase Monitor 
utility. The log provides details of communication difficulties, such as repeated 
busy signals, loss of connection and data errors. The log display can be set to 
show messages about communication with all recorders.

The activity log is circular, the oldest entries are automatically over written 
when its maximum size is reached. The size of RecordBase logs is set through 
the Log Info tab of the RecordBase Collector module. 

Changing the Diagnostic Log size clears all log entries.
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6 RecordBase Administrator

The RecordBase Administrator module is a tool that lets you manage the Re-
cordBase Central Station database. RecordBase Administrator is identical to 
RecordBase View, except for the addition of:

Table 6.1:  

RecordBase Administrator RecordBase View

Records->Delete option is available Records->Delete option is available (with an excep-
tion to delete record(s) from the server database) 

Options->Record Classification 
option is available

Options->Record Classification option is not availa-
ble

File->Open option is not available File->Open option is available

Records->Transfer records option is 
not available

Records->Transfer records option is available

Refer to RecordBase View User Manual for further instructions.
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6 RecordBase Administrator
6.1 Record Classification System
RecordBase Administrator lets you define a record classification system for la-
belling records. Each record can be manually assigned a classification when it 
has been analyzed. The class is assigned using the Classification pick list. Up 
to 10 classes can be defined. Enter the text for each class in the Name column.

Figure 6.1:  Record Classification Window

1.  Open the Record Classification window by selecting the menu Options> 
Record Classification. 

2.  Close the Record Classification window when done. Changes are automat-
ically saved.
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6 RecordBase Administrator
6.2 Deleting Records
To delete a record, select the record from the record list using the mouse and 
select the Delete button in the main Windows toolbar, or pressing the Delete 
key. You are prompted for confirmation before deleting. Multiple records can 
be selected by using the mouse while holding down the shift key (for a contin-
uous block of records) or the Ctrl key (for a non-continuous block of records).
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